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READ ME FIRST m

READ THIS MANUAL COMPLETELY BEFORE
ASSEMBLING AND POWERING UP YOUR PRINTER!

HAZARDS AND WARNINGS

The Artillery Genius Pro 3D Printer has motorized and heated parts.
When the printer is in operation, always be aware of possible
hazards.

ELECTRIC SHOCK HAZARD

Never open the electronics bay of the printer while the printer is
powered on. Before removing the access panel, always power
down the printer and unplug the AC power cord.

BURN HAZARD

Never touch the extruder nozzle, the heater block, or the heated bed
without first turning off the hotend and heated bed and allowing
it to completely cool down. The hotend and heated bed can take
up to twenty minutes to completely cool down. Also, never touch
recently extruded filaments. The filament can stick to your skin and
cause a burn.

FIRE HAZARD

Never leave flammable materials or liquids on or near the printer when
powered on or in operation. Liquid acetone and vapors are extremely
flammable.

PINCH HAZARD

When the printer is in operation, be careful never to put your fingers in
the moving parts, including the belts, pulleys, gears, wheels, or lead
Screws.

STATIC CHARGE

Make sure to ground yourself before touching the printer, especially the
electronics. Electrostatic charges can damage electronic components.
To ground yourself, touch a grounded source.

AGE WARNING
For users under the ages of 18, adult supervision is recommended.
Beware of choking hazards around children.
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LEGAL
PRODUCT WARRANTY

The Artillery Genius Pro 3D Printer is covered by a limited warranty.
For terms and conditions, see https://desk.zoho.com/portal/
evnovo/en/kb/articles/evnovo-limited-warranty

OVERALL PROVISIONS

All information in this user manual ( “Manual” ) is subject to
change at any time without notice and is provided for convenience
purposes only. Shenzhen Yuntuchuangzhi Technology Co., Ltd. and
our respective affiliates and suppliers ( “Artillery” ) reserves the
right to modify or revise this Manual in its sole discretion and at
any time and makes no commitment to provide any such changes,
updates, enhancements, or other additions to this Manual in a
timely manner or at all. You agree to be bound by any modifications
and/or revisions. Contact the Artillery Support Team for up-to-date
information.

INTELLECTUAL PROPERTY

Thedesign ofthis Manualand alltext, graphics, information, content,
and other material are protected by copyright and other laws. The
contents are copyright 2021 Artillery. All rights reserved. Certain
trademarks, trade names, and logos (the "“Marks” ) used in this
Manual are registered and unregistered trademarks, trade names
of Artillery and its affiliates. Nothing contained in this Manual grants
or should be constructed as granting, by implication, estoppel, or
otherwise, any license or right to use without the written permission
of Artillery. Any unauthorized use of any information, materials, or
Marks may violate copyright laws, trademark laws, laws of privacy
and publicity, and/or other laws and regulations.



DISCLAIMERS

Artillery does not warrant the accuracy or completeness of the
information, products, or services provided by or through this
Manual and assumes no responsibility for any typographical,
technical, or other inaccuracies in this Manual, which is provided

“asis” and without any express or implied warranties of any kind,
including warranties of merchantability, fitness for a particular
purpose, or non-infringement of intellectual property. In connection
with your use of this Manual, Artillery shall not be liable to you for
any damages whatsoever, be they direct, economic, commercial,
special, consequential, incidental, exemplary, or indirect damages,
even if Artillery has been advised of the possibility of such damages,
including without limitation, loss of business revenue or earnings,
lost data, or lost profits. Artillery assumes no responsibility, nor
will be liable, for any damages to, or any viruses or malware that
may infect, your computer, telecommunication equipment, or
other property caused by or arising from your downloading of
any information or materials related to this Manual. The foregoing
exclusions do not apply to the extent prohibited by law please refer
to your local laws for any such prohibitions.



LETTER FROM ARTILLERY

Dear Customer,
Thank you for choosing Artillery Genius Pro 3D Printer.

This guide will step you through the assembly and the first run of the
printer. If you have any problems during assembly, please contact our
customer service or visit our official Facebook group at:

https://www.facebook.com/groups/artillerygeniuspro/

For a detailed warranty policy, please visit
https://desk.zoho.com/portal/evnovo/kb/articles/evnovo-limited-
warranty

For support, please send an email to support@artillery3d.com
or visit our ticketing page at
https://desk.zoho.com/portal/evnovo/newticket

Or you can visit our Facebook group at
https://www.facebook.com/artillery3d

Regards,
Artillery

Shenzhen Yuntu Chuangzhi Technology Co., Ltd.

Last update date: 31 August 2021

This manual is updated to the date of printing,

please refer to the electronic version if in doubt.
- 6 -



ACCESSORY CHECKLIST m
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ASSEMBLY

Align the XZ gantry to the base, make sure the connector is perfectly
aligned to the female connector on the base.

STEP 2

The M5 screws used to fasten the XZ gantry to the base are pre-inserted
into the extrusion, use the Allen key provided to tighten the screws.

Push the aluminum extrusions against the inside of the slot when tight-
ening the screws.




STEP 3

Assemble the spool holder as shown in picture, then slide it into the

slots on the top of the top beam. Then use the knob supplied to fix it in
place.




STEP 4

Connect the Z stepper motors and filament runout sensor.
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STEP 5

Loosen the 6 screws holding the carriages on both sides then tighten
them ONLY when wheels on Z carriages not properly seating on the
aluminum extrusions.

h 3
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STEP 6

Adjust the bed carriage and hotend carriage by turning the eccentric
nuts with the wrench supplied.




LEVELING THE BUILD PLATE

The Genius Pro comes with Auto Bed Leveling Sensor, it will perform
a self-test when you power on the printer, if it doesn't, please do
not proceed and check on the cables to make sure they're correctly
seated.

Home the printer;

Heat up the bed and the hotend to 70 ° C and 240 ° C respectively;

Go to Tools -> Level;

Slide a piece of A4 paper between the nozzle and the build plate;

Move the hotend to all 4 corners to repeat step 6;

Turn the leveling knob under the bed closest to the nozzle until the

piece of paper slides, with just a bit of drag;

From the menu, go to Tools -> More and click on Auto-Level;

The printer will initialize the auto bed leveling procedure, wait till it

finishes;

9. Click EEPROM Save;

10.Do the following only if the nozzle is scratching on the build plate or
the nozzle too far from the build plate;

11.Heat up the bed and the hotend to 70 ° C and 240 ° C respectively;

12.Go to Tools -> More -> Z=0;

13.The nozzle will move to the center and at 0 height;

14.Slide the A4 paper between the nozzle and bed again, use +0.025
and -0.025 button to adjust the nozzle distance from the build plate
until the piece of paper slides, with just a bit of drag;

15.Click EEPROM Save once you're happy with the drag on the A4 paper;

16.Repeat Step 2 to Step 9.

17.To enable compensation for auto-leveling, add M420 S1 Z10 after

G28 in starting Gcode.

ok wNeE
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PREPARING SLICING SOFTWARE

This printer works with most slicing software like Slic3r, Cura,
Simplify3D, etc. But we will go into detail about Cura software and
tell you how to set it up so that you can make your first print. First,
please download the software from their official site.

After installation and start the software, you should see the
following screen, continue until you see Add a printer page:

-13 -
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In the Add a non-networked printer, scroll down to Artillery and
choose Artillery Genius, and type in Artillery Genius Pro in Printer
name. Then click on Next button.

B -
Machine Settings
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Set X (Width), Y (Depth) as 220, Z (Height) as 250. Make sure Heated
Bed is checked.
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Machine Settings
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Make sure Compatible material diameter is set to 1.75

Drag and drop the STL file (or other supported formats) to the slicer
or load the model file with File -> Open File(s)...

-15 -



= -0 lmm W & o & g #

From the Profile dropdown, choose the preferred profile.

Click on Slice button.

-16 -



: Py

You can click on Save to Removable Drive or Save to file button to
save the sliced file to the memory card/USB Drive.

Save the file to the USB drive/memory card for printing.
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Insert the USB Drive / memory card into the printer then click on
PRINT.

ReadyPrint>ChooseFile

Choose the file you want to print.

-18 -



ReadyPrint>. .. *Confirm

Print this model?

Base_Body. gcode

Click on Confirm and the print should start.
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SPECIFICATIONS

Print Technology: Fused Deposition Modeling

Build Volume: 220x220x250 mm (8.7x8.7x9.8 in)
Layer Resolution: 100-300 microns

Filament: 1.75 mm (0.069 in)

Nozzle Diameter: 0.4 mm (0.015in)

Print File Type: Gcode

Material Compatibility: PLA, PETG, TPU

Product Dimensions: 430x390%x590 mm (16.9x15.4x23.2 in)
Shipping Box: 528x428x310 mm (20.8x16.9x12.2 in)
Printer Weight: 9.6 kg (21.2 lbs)

Shipping Weight: 11.7 kg (25.8 lbs)

Power Requirements: 110V/220V, 350W

Connectivity: Memory Card, USB Stick, USB
Construction: Aluminum, ABS

Build Surface: Glass + Aluminum plate

Stepper Motors: 1.8° step angle with 1/256 micro-stepping

XY Positioning Precision: 10 microns
Z Positioning Precision: 100 microns

-20 -



CONTACT m

Support desk.zoho.com/portal/evnovo/en/newticket
. At Atrtillery, we take pride in offering expert,
responsive, friendly customer support to
¢ customers around the world. If you need help
. resolving an issue with your Artillery 3D printer,
visit the web address above to submit a ticket.

ooooooooooooooooooooooooooooooooooooooooooooooooooooo

Sales . ytcz@artillery3d.com
ETo learn about other Artillery products, please
: email the address above.

ooooooooooooooooooooooooooooooooooooooooooooooooooooo

Feedback . ytcz@artillery3d.com
For general questions, or to tell us what's on
+ your mind, send an email to the address above.
. We love to hear from you.

-21 -
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LIES MICH ZUERST !

LESEN SIE DIESES HANDBUCH VOLLSTANDIG, BEVOR SIE
IHREN DRUCKERZUSAMMENBAUEN UND EINSCHALTEN!

GEFAHREN UND WARNUNGEN

Der Artillery Genius Pro 3D-Drucker verfliigt Glber motorisierte und
beheizte Teile. Beachten Sie immer madgliche Gefahren, wenn der
Drucker in Betrieb ist.

STROMSCHLAGGEFAHR

Offnen Sie niemals den Elektronikschacht des Druckers, wahrend
der Drucker eingeschaltet ist. Schalten Sie den Drucker immer aus
und ziehen Sie das Netzkabel ab, bevor Sie die Zugangsklappe
entfernen.

VERBRENNUNGSGEFAHR

BerUhren Sie niemals die Extruderdiise, den Heizblock oder das
beheizte Bett, ohne es vollstandig abkthlen zu lassen. Es kann bis
zu zwanzig Minuten dauern, bis das heiBe Ende und das beheizte
Bett vollstandig abgekiihlt sind. Berlihren Sie auch niemals ktirzlich
extrudierte Filamente. Das Filament kann an lhrer Haut haften und
Verbrennungen verursachen.

BRANDGEFAHR

Lassen Sie niemals brennbare Materialien oder Flissigkeiten auf oder
in der Nahe des Druckers, wenn dieser eingeschaltet oder in Betrieb ist.
Flussiges Aceton und Dampfe sind extrem entflammbar.

QUETSCHGEFAHR

Achten Sie beim Betrieb des Druckers darauf, dass Sie niemals lhre Finger
in die beweglichen Teile Stecken. Wie z.B: Riemen, Rlemenscheiben,
Zahnrader, Rader oder Gewindespindeln.

STATISCHE AUFLADUNG

Stellen Sie sicher, dass Sie sich geerdet haben, bevor Sie den Drucker
bertihren, insbesondere die Elektronik. Elektrostatische Aufladungen
kénnen elektronische Komponenten beschadigen. Berlihren Sie eine
geerdete Quelle, um sich selbst zu erden.

ALTERSWARNUNG

FUr Benutzer unter 18 Jahren wird die Aufsicht durch Erwachsene
empfohlen. Achten Sie auf Erstickungsgefahren bei Kindern.

-23-



RECHTLICHES

Fir den Artillery Genius Pro 3D-Drucker gilt eine eingeschrankte
Garantie. Allgemeine Geschaftsbedingungen finden Sie unter
https://desk.zoho.com/portal/evnovo/en/kb/articles/evnovo-
limited-warranty

GESAMTBESTIMMUNGEN

Alle Informationen in dieser Bedienungsanleitung ( “Handbuch” )
kénnen jederzeit ohne vorherige Ankiindigung gedndert werden
und dienen nur der Ubersichtlichkeit. Shenzhen Yuntuchuangzhi
Technology Co., Ltd. und unsere jeweiligen verbundenen
Unternehmen und Lieferanten ( “Artillery” ) behalten sich das
Recht vor, dieses Handbuch nach eigenem Ermessen und jederzeit
zu andern oder zu Uberarbeiten, und verpflichten sich nicht, solche
Anderungen, Aktualisierungen, Verbesserungen, oder andere
Ergdnzungen zu diesem Handbuch rechtzeitig oder Uberhaupt
nicht. Sie stimmen zu, an Anderungen und / oder Uberarbeitungen
gebunden zu sein. Wenden Sie sich an das Artillery Support Team,
um aktuelle Informationen zu erhalten.

GEISTIGES EIGENTUM

Das Design dieses Handbuchs sowie alle Texte, Grafiken,
Informationen, Inhalte und sonstigen Materialien sind durch das
Urheberrecht und andere Gesetze geschiitzt. Der Inhalt unterliegt
dem Copyright 2021 Artillery. Alle Rechte vorbehalten. Bestimmte in
diesem Handbuch verwendete Marken, Handelsnamen und Logos
(die "Marken” )sind eingetragene und nicht eingetragene Marken,
Handelsnamenvon Artilleryund seinenverbundenen Unternehmen.
Nichts, was in diesem Handbuch enthalten ist, gewahrt oder
sollte so konstruiert werden, dass implizit, in irgendeiner Form
oder auf andere Weise eine Lizenz oder ein Nutzungsrecht ohne
die schriftliche Genehmigung von Artillery gewahrt wird. Jede
nicht autorisierte Verwendung von Informationen, Materialien
oder Marken kann gegen Urheberrechtsgesetze, Markengesetze,
Datenschutz- und Publizitatsgesetze und / oder andere Gesetze
und Vorschriften verstoBen.
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HAFTUNGSAUSSCHLUSS

Artillery Ubernimmt keine Gewdahr fur die Richtigkeit oder
Vollstandigkeit der Informationen, Produkte oder Dienstleistungen,
die durch oder durch dieses Handbuch bereitgestellt werden, und
dbernimmt keine Verantwortung fir typografische, technische
oder andere Ungenauigkeiten in diesem Handbuch, das “wie
besehen” wund ohne ausdrickliche Angaben bereitgestellt wird
oder implizite Garantien jeglicher Art, einschlieBlich Garantien der
Marktgangigkeit, der Eignung fir einen bestimmten Zweck oder
der Nichtverletzung von geistigem Eigentum. Im Zusammenhang
mit lhrer Verwendung dieses Handbuchs haftet Artillery lhnen
gegeniiber nicht fir Schaden jeglicher Art, sei es direkte,
wirtschaftliche, kommerzielle, besondere, Folgeschaden, zuféllige,
beispielhafte oder indirekte Schaden, selbst wenn Artillery auf die
MaéglichkeithingewiesenwurdevonsolchenSchaden, einschlieBlich,
ohne Einschrénkung, Verlust von Geschaftserlésen oder -ertrégen,
Datenverlust oder entgangenen Gewinn. Artillery Gbernimmt keine
Verantwortung oder Haftung fir Schaden oder Viren oder Malware,
die lhren Computer, lhre Telekommunikationsgerdte oder andere
Gegenstande infizieren kdnnen, die durch das Herunterladen
von Informationen oder Materialien im Zusammenhang mit
diesem Handbuch verursacht wurden oder daraus entstehen.
Die vorstehenden Ausschliisse gelten nicht in dem gesetzlich
verbotenen Umfang. Informationen zu solchen Verboten finden Sie
in lhren ortlichen Gesetzen.

- 25 -



BRIEF DER ARTILLERY

Sehr geehrter Kunde,

Vielen Dank, dass Sie sich fir den Artillery Genius Pro 3D-Drucker
entschieden haben.

Diese Anleitung fihrt Sie durch die Baugruppe und den ersten
Durchlauf des Druckers. Wenn Sie wahrend der Montage Probleme
haben, wenden Sie sich bitte an unseren Kundenservice oder besuchen
Sie unsere offizielle Facebook-Gruppe unter:

https://www.facebook.com/groups/artillerygeniuspro/

Detaillierte Garantiebestimmungen finden Sie unter

https://desk.zoho.com/portal/evnovo/kb/articles/evnovo-limited-
warranty

Flr Support senden Sie bitte eine E-Mail an support@artillery3d.com
oder besuchen Sie unsere Ticketseite unter

https://desk.zoho.com/portal/evnovo/newticket

Oder besuchen Sie unsere Facebook-Gruppe unter
https://www.facebook.com/artillery3d

GriBe,

Artillery

Shenzhen Yuntu Chuangzhi Technology Co., Ltd.

Datum des letzten Updates: August 31, 2021

Dieses Handbuch wird auf das Druckdatum aktualisiert.

Im Zweifelsfall beziehen Sie sich bitte auf die elektronische Version.
-26 -
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MONTAGE

SCHRITT 1

Richten Sie das XZ-Portal an der Basis aus und stellen Sie sicher, dass
der Stecker perfekt auf die Buchse an der Basis ausgerichtet ist.

SCHRITT 2

Die M5-Schrauben zur Befestigung des XZ-Portals an der Basis sind
bereits in das Profil eingesetzt, verwenden Sie den mitgelieferten In-
busschlussel zum Anziehen der Schrauben.

Driicken Sie beim Anziehen der Schrauben die Aluminiumprofile gegen
die Innenseite des Schlitzes.




SCHRITT 3 m

Montieren Sie den Spulenhalter wie in der Abbildung gezeigt und
schieben Sie ihn dannin die Schlitze oben am oberen Trager. Befestigen
Sie es dann mit dem mitgelieferten Knopf.

- 20 -



SCHRITT 4

SchlieBen Sie die Z-Schrittmotoren und den Rundlaufsensor an.
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SCHRITT 5 m

Losen Sie die 6 Schrauben, die die Wagen auf beiden Seiten halten, und
ziehen Sie sie NUR fest, wenn die Rader der Z-Schlitten nicht richtig auf
den Aluminiumprofilen sitzen.

h 3
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SCHRITT 6

Stellen Sie den Bettwagen und den Hotend-Wagen ein, indem Sie die
Exzentermuttern mit dem mitgelieferten Schraubenschliissel drehen.




DRUCKPLATTE AUSRICHTEN (LEVELN)

DerGeniusProwirdmiteinemautomatischenBettnivellierungssensor
geliefert. Er fUhrt einen Selbsttest durch, wenn Sie den Drucker
einschalten. Wenn dies nicht der Fall ist, fahren Sie bitte nicht fort
und Uberprifen Sie die Kabel, um sicherzustellen, dass sie richtig
sitzen.

Den Drucker nach Hause bringen.

Heizen Sie das Bett und das Hotend auf 70 ° C bzw. 240 ° C auf.

Gehen Sie zu Tools -> Level.

Schieben Sie ein Stick A4-Papier zwischen die Dise und die

Bauplatte.

Bewegen Sie das Hotend in alle 4 Ecken, um Schritt 6 zu wiederholen.

6. Drehen Sie den Nivellierknopf unter dem Bett, das der Dise am
nachsten liegt, bis das Stlick Papier mit nur wenig Widerstand gleitet.

7. Gehen Sie im Men(i zu Tools -> More und klicken Sie auf Auto-Level.

8. DerDrucker initialisiert den automatischen Bettnivellierungsvorgang
und wartet, bis er abgeschlossen ist.

9. Klicken Sie auf EEPROM Save.

10.Flhren Sie die folgenden Schritte nur aus, wenn die Dise auf der
Bauplatte kratzt oder die Duise zu weit von der Bauplatte entfernt ist.

11.Heizen Sie das Bett und das Hotend auf 70 ° C bzw. 240 ° C auf;

12.Gehen Sie zu Tools -> More -> Z = 0;

13.Die Dlise bewegt sich in die Mitte und in H6he von 0;

14.Schieben Sie das A4-Papier erneut zwischen Dlse und Bett. Stellen
Sie mit den Tasten +0.025 und -0.025 den Dusenabstand von der
Bauplatte ein, bis das Blatt Papier mit nur geringem Widerstand
gleitet.

15.Klicken Sie auf EEPROM Save, wenn Sie mit dem Ziehen des A4-
Papiers zufrieden sind.

16.Wiederholen Sie die Schritte 2 bis 9.

17.Um die Kompensation fir die automatische Nivellierung zu

aktivieren, fligen Sie M420 S1 Z10 nach G28 im Start-Gcode hinzu.

PwNPE

u
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SLICING-SOFTWARE VORBEREITEN

Dieser Drucker funktioniert mit den meisten Slicing-Programmen
wie Slic3r, Cura, Simplify3D usw. Wir werden jedoch detailliert m
auf die Cura-Software eingehen und Ihnen erkldren, wie Sie sie
einrichten, damit Sie lhren ersten Druck erstellen kbnnen. Laden Sie
zundachst die Software von der offiziellen Website herunter.

Nach der Installation und dem Starten der Software sollte der
folgende Bildschirm angezeigt werden. Fahren Sie fort, bis die Seite
Druckerseite angezeigt wird:




P Dosihan birmdigen

Elnan Drucker RinzuTuoeas

Vet

Scrollen Sie unter Hinzufligen eines nicht vernetzten Druckers
nach unten zu Artillery, wahlen Sie Artillery Genius und geben
Sie Atrtillery Genius Pro als Druckername ein. Klicken Sie dann auf

Weiter.
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Setbefideh

Stellen Sie X (Breite), Y (Tiefe) auf 220, Z (Hohe) auf 250 ein. Stellen
Sie sicher, dass Heizbares Bett aktiviert ist.
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Andern Sie Kompatibler Materialdurchmesser auf 1,75

Ziehen Sie die STL-Datei (oder andere unterstiitzte Formate) per
Drag & Drop in den Slicer oder laden Sie die Modelldatei mit Datei
-> Datei (en) 6ffnen ...v
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Wahlen Sie das bevorzugte Profil.

Klicken Sie auf die Schaltflache Slice.
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Sie kénnen auf Speichern auf Wechseldatentrager (wenn die
Speicherkarte erkannt wird) oder auf In Datei speichern klicken, um
die geschnittene Datei auf der Speicherkarte zu speichern.

Navigieren Sie zur Speicherkarte und importieren Sie die
Profildateien.

-37-



Stecken Sie das USB-Laufwerk / die Speicherkarte in den Drucker
und klicken Sie auf PRINT.

ReadyPrint>ChooseFile

Waéhlen Sie die Datei aus, die Sie drucken mochten.

- 38 -



ReadyPrint>. .. *Confirm

Print this model?

Base_Body. gcode

Klicken Sie auf Confirm und der Druck sollte beginnen.

- 30 -



SPEZIFIKATIONEN

Drucktechnologie: Fused Deposition Modeling

Build Volume: 220x220x250 mm (8,7x8,7x9,8 Zoll)
Ebenenauflésung: 100-300 Mikrometer

Filament Durchmesser: 1,75 mm (0,069 in)
DUsendurchmessern: 0,4 mm (0,015in)

Dateityp drucken: Gcode

Materialvertraglichkeit:  PLA, PETG, TPU

GROSSE GEWICHT
Produktabmessungen: 430x390x590 mm (16,9x15,4x23,2 Zoll)

Versandkarton: 528x428x310 mm (20,8x16,9x12,2 Zoll)
Druckergewicht: 9,6 kg (21,2 lbs)

Liefergewicht: 11,7 kg (25,8 lbs)

Leistungsbedarf: 110V/220V, 350W

Konnektivitat: Speicherkarte, USB-Laufwerk, USB
Konstruktion: Aluminium, ABS

Oberflache bauen: Glas + Aluminiumplatte

Schrittmotoren: 1,8 ° Schrittwinkel mit 1/256 Mikroschritt

XY Positioniergenauigkeit: 10 Mikrometer
Z Positioniergenauigkeit: 100 Mikrometer

-40 -



Unterstiitzung

Umsatz

Feedback

KONTAKT

desk.zoho.com/portal/evnovo/en/newticket
. WirbeiArtillery sind stolzdarauf, Kunden auf der
ganzen Welt kompetenten, reaktionsschnellen
cund freundlichen Kundensupport zu bieten.
. Wenn Sie Hilfe bei der Lésung eines Problems
-mit lhrem Artillery 3D-Drucker bendtigen,
besuchen Sie die oben angegebene
* Webadresse, um ein Ticket einzureichen.

@ e 0 0000000000000 0000000000000 00000 0 00

. ytcz@artillery3d.com

EUm mehr Gber die Produkte anderer Atrtillery
: zu erfahren, senden Sie bitte eine E-Mail an die
: oben angegebene Adresse.

@ e 0 0000000000000 0000000000000 00000 0 00

. ytcz@artillery3d.com

EWenn Sie allgemeine Fragen haben oder uns
+ mitteilen méchten, was Sie denken, senden Sie
. eine E-Mail an die oben angegebene Adresse.
. Wir freuen uns von lhnen zu héren.
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LEEME PRIMERO

LEA ESTE MANUAL POR COMPLETO ANTES DE
ENSAMBLARY ENCENDER SU IMPRESORA.

PELIGROS Y ADVERTENCIAS

La impresora Artillery Genius Pro 3D tiene piezas motorizadas vy
calentadas. Cuando la impresora esté en funcionamiento, siempre
esté esté siempre atento a los posibles peligros.

PELIGRO DE DESCARGA ELECTRICA

Nunca abra el compartimiento de la electrénica de la impresora
mientras la impresora esta encendida. Antes de retirar el panel
de acceso, siempre apague la impresora y desenchufe el cable de
alimentacion de corriente.

PELIGRO DE QUEMADURAS

Nunca toque la boquilla del extrusor, el bloque calefactor o la cama
caliente sin antes apagar el hotend y la cama caliente y dejar que
se enfrie por completo. El hotend y la cama caliente pueden tardar
hasta veinte minutos en enfriarse por completo. Ademads, nunca
toque los filamentos recién extruidos. El filamento puede adherirse
a su piely causarle quemaduras.

PELIGRO DE INCENDIO

Nunca deje materiales o liquidos inflamables encima o cerca de la
impresora cuando esté encendida o en funcionamiento. La acetona
liquida y sus vapores liquidos son extremadamente inflamables.

PELIGRO DE ATRAPAMIENTO

Cuando la impresora esté en funcionamiento, tenga cuidado de no
meter los dedos en las piezas moviles, incluidas las correas, poleas,
engranajes, ruedas o tornillos de avance.

CARGA ESTATICA

Asegurese de conectarse a tierra antes de tocar la impresora,
especialmente los componentes electronicos. Las cargas electrostaticas
pueden dafar los componentes electronicos. Para conectarse a tierra,
toque una fuente conectada a tierra.

ADVERTENCIA DE EDAD

Para usuarios menores de 18 afos, se recomienda la supervision de un
adulto. Tenga cuidado con los peligros de asfixia en nifios.
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LEGALIDAD
LA GARANT/A DEL PRODUCTO

La impresora 3D Artillery Genius Pro esta cubierta por una garantia
limitada. Para conocer los términos y condiciones, consulte https://
desk.zoho.com/portal/evnovo/en/kb/articles/evnovo-limited-
warranty

DISPOSICIONES GENERALES

Toda la informacion contenida en este manual de usuario
( “Manual” )estasujetaacambiosen cualquiermomentosin previo
aviso y se proporciona unicamente con fines practicos. Shenzhen
Yuntuchuangzhi Technology Co., Ltd. y nuestras respectivas filiales
y proveedores ( "Artilleria” ) se reservan el derecho modificar o
revisar este manual a su entera discrecion y en cualquier momento
y No se compromete a proporcionar tales cambios, actualizaciones,
mejoras u otras adiciones a este manual de manera oportuna o en
absoluto. Usted acepta estar sujeto a cualquier modificaciony / o
revisiones Comuniquese con el Equipo de Apoyo de Artillery para
obtener informacion actualizada.

PROPIEDAD INTELECTUAL

El disefio de este manual y todo el texto, graficos,
informacion, contenido y otros materiales estan protegidos
por derechos de autor y otras leyes. Los contenidos son
copyright 2021 Artillery. Todos los derechos reservados.
Ciertas marcas comerciales, nombres comerciales vy
logotipos (las “Marcas” ) que se utilizan en este manual son
marcas comerciales registradas y no registradas, nombres
comerciales de Artillery y sus filiales. Nada de lo contenido
en este Manual otorga o debe interpretarse como una
concesion, por implicacién, impedimento legal o de otro
modo, cualquier licencia o derecho de uso sin el permiso por
escrito de Artillery. Cualquier uso no autorizado de cualquier
informacion, materiales o Marcas puede violar las leyes de
derechos de autor, las leyes de marcas registradas, las leyes
de privacidad y publicidad y / u otras leyes y regulaciones.
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AVISO LEGAL

Artillery no garantiza la exactitud o integridad de la informacion,
los productos o los servicios proporcionados por este Manual oa
través de este y no asume ninguna responsabilidad por cualquier
inexactitud tipografica, técnica o de otro tipo en este Manual, que se
proporciona “tal cual” vy sin ningun tipo de o garantias implicitas
de cualquier tipo, incluidas las garantias de comerciabilidad,
idoneidad para un proposito particular o no infraccién de la
propiedad intelectual. En relacion con el uso de este Manual,
Artillery no sera responsable ante usted por ningun dafio, ya sea
directo, econdmico, comercial, especial, consecuente, incidental,
ejemplar o indirecto, incluso si Artillery ha sido advertido de la
posibilidad. de dichos dafios, incluidos, entre otros, la pérdida de
ingresos o ganancias comerciales, la pérdida de datos o la pérdida
de beneficios. Artillery no asume ninguna responsabilidad, ni sera
responsable, por ningun dafio o virus o malware que pueda infectar
su computadora, equipo de telecomunicaciones u otra propiedad
causada por o que surja de la descarga de cualquier informacion
0 material relacionado con este manual. Las exclusiones anteriores
no se aplican en la medida en que lo prohiba la ley. Consulte las
leyes locales para conocer dichas prohibiciones.
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CARTA DE ARTILLERY

Estimado cliente,
Gracias por elegir la impresora 3D Atrtillery Genius Pro.

Esta guia le orientara en el ensamblaje y la primera puesta en marcha
de la impresora. Si tiene algun problema durante el montaje, pongase
en contacto con nuestro servicio de atencion al cliente o visite nuestro
grupo oficial de Facebook en:

https://www.facebook.com/groups/artillerygeniuspro/

Para obtener una politica de garantia detallada, visite

https://desk.zoho.com/portal/evnovo/kb/articles/evnovo-limited-
warranty

Para soporte, envie un correo electrénico a support@artillery3d.com
0 visite nuestra pagina de venta de entradas en

https://desk.zoho.com/portal/evnovo/newticket

O puede visitar nuestro grupo de Facebook en
https://www.facebook.com/artillery3d
Saludos,

Artillery

Shenzhen Yuntu Chuangzhi Technology Co., Ltd.
Ultima Fecha de Actualizacion: agosto 31, 2021

Este manual esta actualizado a la fecha de impresion,
consulte la version electronica en caso de duda.
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LISTA DE VERIFICACION DE ACCESORIOS
(GENIIUS) e,
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MONTAJE DE LA IMPRESORA

Alinee el portico XZ con la base, asegurese de que el conector esté
perfectamente alineado con el conector hembra de la base.

PASO 2

Los tornillos M5 que se utilizan para sujetar el portico XZ a la base estan
insertados previamente en la extrusion; utilice la llave Allen proporcio-
nada para apretar los tornillos.

Empuje las extrusiones de aluminio contra el interior de la ranura cuan-
do apriete los tornillos.

- 68 -



Ensamble el portacarretes como se muestra en la imagen, luego
deslicelo en las ranuras en la parte superior de la viga superior. Luego
use la perilla suministrada para fijarlo en su lugar.

- 69 -



PASO 4

Conecte los motores paso a paso Z y el sensor de agotamiento del

filamento.
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Afloje los 6 tornillos que sujetan los carros en ambos lados y luego
apriételos SOLAMENTE cuando las ruedas de los carros Z no se asienten
correctamente en las extrusiones de aluminio.

PASO 6

Ajuste el carro de la cama vy el carro del hotend girando las tuercas
excéntricas con la llave suministrada.




NIVELACION DE LA PLACA DE CONSTRUCCION

El Genius Pro viene con un sensor de nivelacion automatica de la
cama, realizara una autoprueba cuando encienda la impresora; si
no lo hace, no proceda y compruebe los cables para asegurarse de
que estén colocados correctamente.

Inicio de la impresora;

Calentar la camay el hotend a 70 ° Cy 240 ° C respectivamente;

Vaya a Tools -> Level,;

Deslice untrozo de papel A4 entre laboquilla y la placa de impresion;

Mueva el hotend a las 4 esquinas para repetir el Paso 6;

Gire la perilla de nivelacion debajo de la cama mas cercana a la

boquilla hasta que la hoja de papel se deslice, con solo un poco de

arrastre;

Desde el menu, vaya a Tools -> More y haga clic en Auto-Level;

8. Laimpresora inicializara el procedimiento de nivelacion automatica
de la cama, espere hasta que finalice;

9. Haga clic en EEPROM Save;

10.Haga lo siguiente solo si la boquilla esta rayando en la placa de
construccion o si la boquilla esta demasiado lejos de la placa de
construccion;

11.Calentar la camay el hotend a 70 ° Cy 240 ° C respectivamente;

12.Vaya a Tools -> More ->Z = 0;

13.La boquilla se movera hacia el centro y a 0 altura;

14.Deslice el papel A4 entre la boquilla y la cama nuevamente, use
los botones +0.025 y -0.025 para ajustar la distancia de la boquilla
desde la placa de construccién hasta que la hoja de papel se deslice,
con solo un poco de arrastre;

15.Haga clic en EEPROM Save una vez que esté satisfecho con el
arrastre en el papel A4;

16.Repita del Paso 2 al Paso 9;

17.Para habilitar la compensacion para la nivelacion automatica,

agregue M420 S1 210 después de G28 en el Gcode inicial.

ok wNeE

N
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PREPARACION DE SOFTWARE DE CORTE

Esta impresora funciona con la mayoria de software de corte
como Slic3r, Cura, Simplify3D, etc. Pero presentaremos en detalle
el software Cura y le diremos como configurarlo para que pueda
realizar su primera impresiéon. Primero, descargue el software de
su sitio oficial.

Después de la instalacion e inicio del software, deberia ver la
siguiente pantalla, continde hasta que vea la pagina Agregar una
impresora:
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En Agregar una impresora no conectada a la red, desplacese hacia
abajo hasta Artillery y elija Artillery Genius, y escriba Artillery
Genius Pro en Nombre de la impresora. Luego haga clicen el botdn
Next.
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farm

Establezca X (anchura), Y (profundidad) como 220, Z (altura) como
250. Asegurese de que la opcién cama caliente (heated bed) esté
marcada.
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Cambie el Diametro del material compatible a 1,75

Arrastre y suelte el archivo STL (u otro formato compatible) en la
cortadora o cargue el archivo del modelo con Archivo -> Abrir
archivo (s) ... luego haga clic en el botén Segmentacion.
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En el menu desplegable Perfil, elija el perfil preferido.

Haga clic en el boton Segmentacion.
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Puede hacer clic en Guardar en unidad extraible (si se detecta la
tarjeta de memoria) o en el botdon Guardar en archivo para guardar
el archivo cortado en la tarjeta de memoaoria.

Guarde el archivo en la tarjeta de memoria para imprimir.
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Inserte la unidad USB / tarjeta de memoria en la impresora 'y
luego haga clic en PRINT.

ReadyPrint>ChooseFile

Elija el archivo que desea imprimir.
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ReadyPrint>. .. *Confirm

Print this model?

Base_Body. gcode

Haga clic en Confirm y la impresion deberia comenzar.
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ESPECIFICACIONES

Tecnologia de impresion: Modelado por deposicion fundida

Volumen de construccion: 220x220x250 mm
(8,7x8,7x9,8 pulgadas)

Resolucion de capa: 100-300 micrones

Diametro del filamento: 1,75 mm (0,069 pulgadas)

Diametro de la boquilla: 0,4 mm (0,015 pulgadas)

Tipo de archivo de impresion:  Gcode

Compatibilidad material: PLA, PETG, TPU

Dimensiones del producto: 430x390x590 mm
(16,9x15,4x23,2 pulgadas)

Caja de envio: 528x428x310 mm
(20,8x16,9x12,2 pulgadas)

Peso de la impresora: 9,6 kg (21,2 libras)

Peso de envio: 11,7 kg (25,8 libras)

Requerimientos de energia: 110V/220V, 350W

Conectividad: Tarjeta SD, Unidad USB, USB

Construccion: Aluminio, ABS

Superficie de construccion: Placa de vidrio + aluminio

Angulo de paso de 1,8° con
micropasos de 1/256

XY Precision de posicionamiento: 10 micrones
Z Precision de posicionamiento: 100 micrones

Motores paso a paso:
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Apoyo

Retroalimentacion

Retroalimentacion

CONTACTO

desk.zoho.com/portal/evnovo/en/newticket
- En Atrtillery, nos enorgullecemos de ofrecer
Suna atencion al cliente experta, receptiva
¢y accesible a clientes de todo el mundo. Si
. necesita ayuda para resolver un problema con
. su impresora Atrtillery 3D, visite la direccién
web anterior para crear un ticket.

. ytcz@artillery3d.com

- Para obtenerinformacion sobre otros productos
: de Artillery, envie un correo electronico a la

: direccion anterior.

. ytcz@artillery3d.com

- Para preguntas generales, o para trasladarnos
: lo que le preocupa, envie un correo electrénico
. a la direccion anterior. Nos encanta saber de

usted.
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ALERTE DE SECURITE

LISEZ COMPLETEMENT CE MANUEL AVANT D'ASSEMBLER
ET DE MISE SOUS TENSION VOTRE IMPRIMANTE!

DANGERS ET AVERTISSEMENTS

L'imprimante 3D Artillery Genius Pro posséde des pieces motorisées
et chauffées. Lorsque l'imprimante est en fonctionnement, soyez
toujours conscient des dangers possibles.

RISQUE D'ELECTROCUTION

N'ouvrez jamais la baie électronique de l'imprimante lorsque
l'imprimante est sous tension. Avant de retirer le panneau d'acces,
mettez toujours l'imprimante hors tension et débranchez le cordon
d'alimentation secteur.

RISQUE DE BRULURE

Ne touchez jamais la buse de l'extrudeuse, le bloc chauffant ou le
lit chauffant sans d'abord éteindre le hotend et le lit chauffant et les
laisser refroidir complétement. Le hotend et le lit chauffant peuvent
prendre jusqu'a vingt minutes pour se refroidir completement. De
plus, ne touchez jamais aux filaments récemment extrudés. Le
filament peut coller a votre peau et provoquer des brdlures.

RISQUE D'INCENDIE

Ne laissez jamais de matériaux ou de liquides inflammables sur
ou a proximité de limprimante lorsqu’elle est sous tension ou en
fonctionnement. Lacétone liquide et les vapeurs sont extrémement
inflammables.

RISQUE DE PINCEMENT

Lorsque l'imprimante fonctionne, veillez a ne jamais mettre vos doigts
dans les pieces mobiles, y compris les courroies, poulies, engrenages,
roues ou vis-meres.

CHARGE STATIQUE

Assurez-vous de vous mettre a la terre avant de toucher l'imprimante,
en particulier l'électronique. Les charges électrostatiques peuvent
endommager les composants électroniques. Pour vous mettre a la
terre, touchez une source mise a la terre.

AVERTISSEMENT D'AGE

Pour les utilisateurs de moins de 18 ans, la surveillance d'un adulte
est recommandée. Méfiez-vous des risques d'étouffement autour des
enfants.
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LEGALE
GARANTIE DU PRODUIT

L'imprimante 3D Artillery Genius Pro est couverte par une garantie
limitée. Pour les termes et conditions, voir https://desk.zoho.com/
portal/evnovo/en/kb/articles/evnovo-limited-warranty

DISPOSITIONS GENERALES

Toutes les informations contenues dans ce manuel d'utilisation
(«Manuel») sont susceptibles d'étre modifiées a tout moment sans
préavis et sont fournies a des fins de commodité uniquement.
Shenzhen Yuntuchuangzhi Technology Co., Ltd. et nos affiliés et
fournisseurs respectifs («Artillery») se réservent le droit de modifier
ou de réviser ce manuel a sa seule discrétion et a tout moment
et ne prend aucun engagement de fournir de tels changements,
mises a jour, améliorations, ou d'autres ajouts a ce manuel en
temps opportun ou pas du tout. Vous acceptez d’étre lié par toute
modification et / ou révision. Contactez l'équipe de soutien de
I'Artillery pour obtenir des informations a jour.

PROPRIETE INTELLECTUELLE

La conception de ce manuel et tous les textes, graphiques,
informations, contenus et autres éléments sont protégés par le droit
d’auteur et d'autres lois. Le contenu est protégé par copyright 2021
Artillery. Tous les droits sont réservés. Certaines marques, noms
commerciaux et logos (les «<Margues») utilisés dans ce manuel sont
des marques déposées et non déposées, des noms commerciaux
d'Artillery et de ses filiales. Rien de ce qui est contenu dans ce
manuel n‘accorde ou ne doit étre interprété comme accordant,
par implication, préclusion ou autrement, une licence ou un droit
d’utilisation sans l'autorisation écrite de Artillery. Toute utilisation
non autorisée de toute information, matériel ou marque peut
enfreindre les lois sur les droits d’auteur, les lois sur les marqgues,
les lois sur la confidentialité et la publicité, et / ou d'autres lois et
réglementations.
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AVERTISSEMENT

L'Artillery ne garantit pas lexactitude ou l'exhaustivité des
informations, produits ou services fournis par ou via ce manuel
et n‘assume aucune responsabilité pour toute inexactitude
typographique, technique ou autre dans ce manuel, qui est
fourni «tel quel» et sans aucune ou des garanties implicites de
toute nature, y compris des garanties de qualité marchande,
d’'adéquation a un usage particulier ou de non-violation de la
propriété intellectuelle. Dans le cadre de votre utilisation de
ce manuel, UArtillery ne sera pas responsable envers vous de
quelque dommage que ce soit, qu’il s'agisse de dommages directs,
économiques, commerciaux, spéciaux, consécutifs, accidentels,
exemplaires ou indirects, méme si l'Artillery a été informée de la
possibilité. de tels dommages, y compris, sans s’y limiter, la perte
de revenus ou de revenus commerciaux, la perte de données ou
la perte de profits. Artillery n‘assume aucune responsabilité et
ne sera pas tenue responsable des dommages ou des virus ou
logiciels malveillants susceptibles d'infecter votre ordinateur, votre
équipement de télécommunication ou toute autre propriété causeés
par ou résultant de votre téléchargement de toute information ou
matériel lié a ce manuel. Les exclusions ci-dessus ne s'appliquent
pas dans la mesure interdite par la loi, veuillez vous référer a vos
lois locales pour de telles interdictions.
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LETTRE DE ARTILLERY

Cher client,
Merci d'avoir chaisi l'imprimante 3D Artillery Genius Pro.

Ce guide vous guidera a travers |'assemblage et la premiere exécution
del'imprimante. Sivous rencontrez des problémes lors de I'assemblage,
veuillez contacter notre service client ou visitez notre groupe Facebook
officiel a l'adresse:

https://www.facebook.com/groups/artillerygeniuspro/

Pour une politique de garantie détaillée, veuillez visiter
https://desk.zoho.com/portal/evnovo/kb/articles/evnovo-limited-
warranty

Pour obtenir de l'aide, veuillez envoyer un e-mail a
support@artillery3d.com

ou visitez notre page de billetterie a
https://desk.zoho.com/portal/evnovo/newticket

Ou vous pouvez visiter notre groupe Facebook a
https://www.facebook.com/artillery3d

Cordialement,

Artillery

Shenzhen Yuntu Chuangzhi Technology Co., Ltd.

Derniére date de mise a jour: 31 ao(t 2021

Ce manuel est mis a jour a la date d'impression,

veuillez vous référer a la version électronique en cas de doute.
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LISTE DE VERIFICATION DES ACCESSOIRES
(GENIIUS) e,




ASSEMBLAGE DE L'IMPRIMANTE

Alignez le portique XZ sur la base, assurez-vous que le connecteur est
parfaitement aligné avec le connecteur femelle de la base.

ETAPE 2

Les vis M5 servant a fixer le portique XZ a la base sont pré-insérées dans
le profilé, utilisez la clé Allen fournie pour serrer les vis.

Poussez les extrusions d'aluminium contre l'intérieur de la fente lors du
serrage des vis.




ETAPE 3

Assemblez le support de bobine comme indiqué sur l'image, puis faites-
le glisser dans les fentes sur le dessus du faisceau supérieur. Utilisez
ensuite le bouton fourni pour le fixer en place.
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ETAPE 4

Connectez les moteurs pas a pas Z et le capteur de voile de filament.
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ETAPE 5

Desserrez les 6 vis qui maintiennent les chariots des deux cétés, puis
serrez-les UNIQUEMENT lorsque les roues des chariots Z ne reposent
pas correctement sur les extrusions d'aluminium.

ETAPE 6

Ajustez le chariot du lit et le chariot du hotend en tournant les écrous
excentriques avec la clé fournie.




ETALONNAGE

Le Genius Pro est livré avec un capteur de nivellement automatique
dullit, ileffectuera un auto-test lorsque vous allumerez l'imprimante,
si ce n'est pas le cas, veuillez ne pas continuer et vérifier les cables
pour vous assurer qu'ils sont correctement installés.

Accueil de l'imprimante;

Chauffer le lit et le hotend a 70 ° C et 240 ° C respectivement;

Allez dans Tools -> Level;

Faites glisser un morceau de papier A4 entre la buse et la plaque de

construction;

Déplacez le hotend aux 4 coins pour répéter 'étape 6;

6. Tournezle bouton de nivellement sous le lit le plus proche de la buse
jusqu’a ce que le morceau de papier glisse, avec juste un peu de
trainée;

7. Dans le menu, allez dans Tools -> More et cliquez sur Auto-Level;

8. Limprimante initialisera la procédure de nivellement automatique
du lit, attendez qu’elle se termine;

9. Cliquez sur EEPROM Save;

10.Ne procédez comme suit que si la buse raye la plaque de construction
ou si la buse est trop éloignée de la plaque de construction;

11.Chauffer le lit et le hotend a 70 ° C et 240 ° C respectivement;

12.Allez dans Tools -> More ->Z =0;

13.La buse se déplacera vers le centre et a une hauteur de 0;

14.Faites glisser a nouveau le papier A4 entre la buse et le lit, utilisez les
boutons +0,025 et -0,025 pour ajuster la distance de la buse a partir
de la plague de construction jusqu'a ce que le morceau de papier
glisse, avec juste un peu de trainée;

15.Cliquez sur EEPROM Save une fois que vous étes satisfait du
glissement sur le papier A4;

16.Répétez les étapes 2 a 9;

17.Pour activer la compensation pour la mise a niveau automatique,

ajoutez M420 S1 Z10 apres G28 au démarrage du Gcode.

PwNPE

u
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PREPARATION DU LOGICIEL DE TRANCHAGE

Cette imprimante fonctionne avec la plupart des logiciels de
découpage comme Slic3r, Cura, Simplify3D, etc. Mais nous allons
aller en détail pour le logiciel Cura et vous dire comment le
configurer pour que vous puissiez faire votre premiére impression.
Tout d'abord, veuillez télécharger le logiciel depuis leur site officiel.

Apres l'installation et le démarrage du logiciel, vous devriez voir
'écran suivant, continuez jusqu'a ce que vous voyiez Ajouter une
page d'imprimante:
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AJoUTEr Une imprimanin
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Artillery Genius
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Ratoimy

Dans Ajouter une imprimante hors réseau, faites défiler jusqu'a
Artillery et choisissez Artillery Genius, puis tapez Artillery Genius
Pro dans Nom de limprimante. Cliquez ensuite sur le bouton
Ajouter.

‘aramerrgs de-la machine

Artillery Gaius Pra

[Erra— ke i
Pararmities e Feprenasts Parasidires de b tite Simprmasen
i -
i v e
' . - [rens—
. i
2 w
[-Ceede gt dEmarmage G-Cosle de fin

Réglez X (Largeur), Y (Profondeur) sur 220, Z (Hauteur) sur 250.
Assurez-vous que le Plateau chauffant est coché.
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Changer le Diameétre du matériau compatible a 1,75

Faites glisser et déposez le fichier STL (ou un autre format pris en
charge) dans le slicer ou chargez le fichier modele avec Fichier ->
Ouvrir le(s) fichier(s)...
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Sélectionnez le Profil préferé.

Cliquez sur le bouton Découper.
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: Py

Vous pouvez cliquer sur Enregistrer sur un lecteur amovible (si
la carte mémoire est détectée) ou sur le bouton Enregistrer sous
Fichier pour enregistrer le fichier découpé sur la carte mémaoire.

Enregistrez le fichier sur la carte mémoire pour l'impression.
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Insérez la clé USB / la carte mémoire dans l'imprimante puis
cliquez sur PRINT.

ReadyPrint>ChooseFile

Choisissez le fichier que vous souhaitez imprimer.
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ReadyPrint>. .. *Confirm

Print this model?

Base_Body. gcode

Cliquez sur Confirm et l'impression devrait commencer.
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CARACTERISTIQUES

Technologie d'impression: modeélisation des dép6bts fondus
Volume de construction: 220x220x250 mm
(8,7x8,7x9,8 pouces)
Résolution de couche: 100 a 300 microns
Diameétre du filament: 1,75 mm (0,069 pouces)
Diameétre de la buse: 0,4 mm (0,015 pouces)
Type de fichier d'impression: Gcode
Compatibilité matérielle: PLA, PETG, TPU

DIMENSIONS ET POIDS
Dimensions du produit: 430x390x590 mm (16,9x15,4x23,2 pouces)

Boite d'expédition: 528x428x310 mm (20,8x16,9x12,2 pouces)
Poids de l'imprimante: 9,6 kg (21,2 livres)

Poids d'expédition: 11,7 kg (25,8 livres)

ELECTRIQUE

Exigences d'alimentation: 110V/220V, 350W

Connectivité: Carte mémoire, clé USB, USB
MECANIQUE

Construction: Aluminum, ABS

Surface de construction: Verre + plaque d'aluminium

Angle de pas de 1,8 ° avec micro-
pas de 1/256

XY Précision de positionnement: 10 microns
Z Précision de positionnement: 100 microns

Moteurs pas a pas:
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CONTACT

Soutien desk.zoho.com/portal/evnovo/en/newticket
. Chez Artillery, nous sommes fiers d'offrir un
fsupport client expert, réactif et amical aux
: clients du monde entier. Si vous avez besoin
. d'aide pour résoudre un probleme avec votre
. imprimante 3D Artillery, visitez l'adresse Web
ci-dessus pour soumettre un ticket.
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Ventes . ytcz@artillery3d.com
EPour en savoir plus sur les autres produits
: d'artillerie, veuillez envoyer un courriel a
['adresse ci-dessus.
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